Racing Systems Analysis

ENGINE Pro
Version 3.1
By: Patrick Hale

Copyright 2007 RSA
www.QUARTERjr.com

COPYRIGHT
Copyright 2076 by RSA. All rights reserved. No part of this publication may
be reproduced, transmitted, stored in a retrieval system, or translated into any
language or computer language, in any form or by any means; electronic,
mechanical, magnetic, optical, chemical, manual or otherwise; without the prior
written consent of Racing Systems Analysis.

DISCLAIMER
RSA reserves the right to revise this publication and to make changes from time
to time in the context hereof, without the obligation of RSA to notify any person
of such revision or changes.

TABLE OF CONTENTS
CHAPTER 1: INTRODUCTION
General. . . . . . . . . . . . . . . . .1 1
Installing your program disk . . . . . .1 4
CHAPTER 2: SAMPLE ENGINE Pro ANALYSIS
Getting started. . . . . . . . . . . . .2 1
Sample ENGINE Pro analysis . . . . . . .2 2
CHAPTER 3: THE COMMAND MENUS
The command menus. . . . . . . . . . . .3 1
File: Open . . . . . . . . . . . . . . .3 1
File: Save . . . . . . . . . . . . . . .3 2
File: Save As. . . . . . . . . . . . . .3 2
File: Print. . . . . . . . . . . . . . .3-3
File: Exit . . . . . . . . . . . . . . .3 3
CHAPTER 4: INPUT VARIABLES
How to input . . . . . . . . . . . . . .4 1
Engine design data . . . . . . . . . . .4 4
Compression ratio worksheet. . . . . . .4 8
Throttle CFM @ 1.5 in Hg worksheet . . 4-10
Intake port flowbench data worksheet . 4 12
- Intake valve seat throat data . . 4-13
- Flowbench data. . . . . . . . . . 4-14
Cross-section area calculator. . . . . 4-17

CHAPTER 5: CALCULATED PARAMETERS
Estimated engine performance . . . . . .5 1
Engine dyno data . . . . . . . . . . . .5-3
ENGINE Pro mechanical details. . . . . .5-3
- Piston speed summary. . . . . . . .5-3
- Geometric data summary. . . . . . .5-4
- Piston details. . . . . . . . . . .5-5
ENGINE Pro intake port flow details. . .5-7
- Piston speed summary. . . . . . . .5-7
- Camshaft description. . . . . . . .5-8
- Flow details. . . . . . . . . . . .5-9
ENGINE Pro recommendations . . . . . . 5-11
- Intake system . . . . . . . . . . 5-12
- Camshaft. . . . . . . . . . . . . 5-13
- Exhaust port. . . . . . . . . . . 5-14
- Exhaust system. . . . . . . . . . 5-15

CHAPTER 1: INTRODUCTION
General
The ENGINE Pro software from RSA quickly estimates the maximum
performance potential for a wide range of naturally aspirated, gasoline and
methanol burning, spark ignition, internal combustion engines. It can be used
with or without cylinder head flowbench data to provide accurate estimates of
what an engine can develop in the way of power and torque, and what the
expected RPM range of the engine will be.
Today, in this 21st century, motorsports and racing has attained a level of
sophistication that makes the personal computer an essential tool for all racers to
use, Professional and Sportsman alike.
The QUARTER Pro and QUARTERjr programs for drag racecar performance
simulation started it all off, first becoming commercially available way back in
1985. Today, thousands of racers just like yourself, already have QUARTERjr
in their "toolbox".
Now, ENGINE Pro unlocks the power and convenience of the personal
computer for every racer who needs to know about their engine's performance,
or how to modify it to make even more horsepower and torque.
The amount of power and torque a modern high performance engine makes is
directly related to the volume and mass of air it pumps and traps. The larger the
mass of air trapped in the cylinder at a given RPM, the more fuel that can be
burned, and the more power and torque the engine will make.
Many factors - or design variables - have a strong influence on the trapped
engine airflow rate including bore stroke ratio, connecting rod length, intake
manifold length and flow capacity, and camshaft timing, to name just a few.
Fuel properties and compression ratio are key factors for determining the
thermodynamic efficiency of the combustion and expansion processes of the
four cycle internal combustion engine.

The ENGINE Pro software from RSA is one of the most accurate means of
determining the effects of these engine design variables on overall engine
performance. It has been calibrated using dyno data from hundreds of high
performance engines, ranging from record holding 4 valve 77 cid Pro Stock
motorcycle engines to championship 800+cid "Mountain Motor" Pro Stock
engines, and everything else in between.
With competitive racing being a contest of hundredths, or even thousandths of a
second, or just fractions of a MPH, only a computer can provide the necessary
consistency and accuracy to help understand, predict and improve your engine's
performance and durability.
RSA (Racing Systems Analysis) was started in 1978 by Patrick Hale, a local
drag racer from Arizona. After drag racing several racecars while attending
Mechanical Engineering school at Arizona State University; he developed the
well known QUARTER Pro and QUARTERjr computer programs. Now, he has
made ENGINE Pro available for overall engine performance simulation.
The services of RSA are also available to customize ENGINE Pro to your
specific needs; and to write new, engineering analysis software for other
applications. Give RSA a call or e-mail. We will be happy to discuss these
possibilities, and future RSA products with you.
Web: www.QUARTERjr.com

Installing your program disk
1. Start by inserting the ENGINE Pro program CD into the appropriate drive in
your PC.
2. Use the mouse to select Run from the Start menu.
3. In the Command Line box, type d:setup.exe depending on which drive you
are using to read the ENGINE Pro setup disk.
4. Use the mouse to click the OK button.
5. Follow the instructions displayed on your computer monitor. When you are
finished, remove the CD.
6. The setup process creates a folder named ENGINE Pro in the Program Files
group. This folder contains the icon for the ENGINE Pro software. The
ENGINE Pro program icon has the name EngPro.exe.
7. You can now create a Shortcut for the EngPro.exe file and Send it to the
Windows desktop if you like. You normally do this by right-clicking the mouse
on the EngPro.exe program icon and then choosing Create Shortcut from the
drop-down list.

CHAPTER 2: SAMPLE ENGINE Pro ANALYSIS
Getting Started
In this chapter, we will walk you through a sample, hands on, engine
performance analysis. So please sit at your computer while you read this
chapter. ENGINE Pro is designed to be very easy to use, even for the first time
or novice computer user.
You can begin using ENGINE Pro in one of two ways. For now, use the mouse
to double-click on the application icon in the ENGINE Pro folder or the
Windows desktop Shortcut you created for ENGPRO.exe. This process starts
loading ENGINE Pro from the hard disk to the random access memory (RAM)
and starts the program running.
The splash screen identifying the version of the ENGINE Pro program you have
will now appear. This will be followed by the ENGINE Pro program screen
including a menu of command options. By choosing one of the menu items
from the two command menus (File and Help), you command ENGINE Pro to
do whatever you choose.
ENGINE Pro can also be started by double-clicking on any ENGINE Pro data
document that you have created and saved.
By double-clicking on an ENGINE Pro data document you can pick right up
where you left off! However, you first need to "register" the ENGINE Pro
application file with the "*.eng" data documents using the Windows "File
Types" manager.

The Windows "File Types" manager is selected by double-clicking on "My
Computer" and selecting "Options" from the "View" command menu. The tab
for setting the application "File Types" can now be selected.
Sample ENGINE Pro Analysis

To begin with, let's take a quick look at the ENGINE Pro program screen before
proceeding to the sample engine performance analysis that follows.

The ENGINE Pro program screen contains all the input design data necessary to
accurately predict the performance potential of an engine. It includes those
engine design variables that research and experience have shown to have the
largest effect on the power and torque capabilities of an internal combustion
engine.
Obviously, these variables include the bore and stroke of the engine design, the
compression ratio, cylinder head flow capacity, and camshaft information.
Other engine design variables include the number of intake valves per cylinder,
fuel type and carburetor or throttle body size.
Any of these data values may easily be changed using the editing features of the
ENGINE Pro program which are fully described in Chapter 4 of this manual.
Now slowly press the Tab key a few times and watch how the cursor moves
around the ENGINE Pro program screen.
You can also use the mouse to select any input variable to modify. Singleclicking allows direct replacement of the input variable value. Double-clicking
on the variable value allows you to insert and delete. You can quickly select any
input variable to edit using your mouse in the normal Windows manner.
You might also try holding down the Tab key and see how you can rapidly get
to any position on the program screen using this alternative method.
That's all there is to it! Try changing the compression ratio to 14.5. Remember
to press the Tab key, (or the Return or Enter keys) after typing 14.5.
Whenever an input variable value is changed, the cursor will momentarily
disappear while ENGINE Pro is calculating the new engine's design
performance. After this very brief period of time, the calculated output
parameters are updated on the program screen.

The calculated output from ENGINE Pro includes the predicted horsepower and
torque peaks for the input engine design. Try pressing the Dyno Data command
button located at the top of the program screen to see the complete engine dyno
data chart.
Press the close box in the upper right-hand corner to return to the main program
screen. Detailed descriptions of all the calculated output parameters are
included in Chapter 5 of this manual.
How much more power can this 355 Chevy make? And at what RPM? What
about trying a 1050 Dominator? A different cam? These are the type of
questions ENGINE Pro was designed to answer, quickly and economically.
ENGINE Pro also includes powerful calculation worksheets available by
pressing any one of three Worksheet buttons at any time. The Worksheet
buttons are located next to their corresponding input variables. Try pressing the
Compression Ratio button located at the compression ratio input variable
location now.
The Compression Ratio Worksheet will now be displayed for easily calculating
the engine compression ratio! The Compression Ratio Worksheet variables are
described starting on page 4-8 of this manual.
The engine's Compression Ratio is automatically calculated as you enter the
worksheet data. Press the close box in the upper right-hand corner of the
Compression Ratio Worksheet to return to the ENGINE Pro program screen
when you are finished using the worksheet.
Note that the calculated compression ratio from the worksheet does not
automatically transfer to the main screen. You must still input any new value
for yourself. However, if you double-click on the calculated value on the
worksheet, the worksheet will close and the new value will be transfered to the
main ENGINE Pro screen. The engine HP and torque are re-calculated any time
any input variable on the main ENGINE Pro program screen.
Press the Recommendations button to display the recommended values for
several intake and exhaust system design variables. Following these
recommendations should provide a "tuned" intake and exhaust system to

maximize volumetric efficiency, and hence obtain the highest torque and
horsepower possible from your engine.
Pressing the Mech Details button will display a special, very detailed screen
where piston speeds are summarized and detailed calculations and graphs
included for specific angles of crank rotation. Chapter 5 contains a complete
description of the ENGINE Pro Recommendations and both the ENGINE Pro
Mechanical and Intake Port Flow Details screens.

Selecting the Exit command from the File menu (or pressing the close box in the
upper right-hand corner) will return your computer to the Windows desktop.

Good luck and have fun! The remaining chapters of this manual provide you
with the detailed knowledge and skills necessary to fully exploit the power and
versatility of ENGINE Pro and your Windows PC.

CHAPTER 3: THE COMMAND MENUS
The Command Menus
Two Windows command menus; File and Help, containing a variety of menu
items are used with ENGINE Pro to specify the command option desired. These
menu options may generally be selected anytime while running the program.
Three of the File menu options - Open, Save and Print are also available by
using command buttons, located just below the Help menu near the top of the
ENGINE Pro program screen.
File: Open
The Open command is used to retrieve from the disk and display on the
ENGINE Pro program screen a previously saved engine design data document.
Selecting Open from the File menu (or pressing the Open command button, the
left button located near the top of the program screen) will cause a standard
Windows dialog box to appear, awaiting the selection of an ENGINE Pro data
document.
Once the input data document is selected, the data values are retrieved and
displayed on the ENGINE Pro program screen as well as the calculated engine
performance parameters for this data. The cursor is always left at the "Note:"
position following this option.
The Open option can be used to open an existing data document so that it may
be modified as desired. The retrieved input data can also serve as a base for
building another data document to be saved using the Save As option described
below.
File: Save
The Save command is used to save the current engine design data on your disk.
Selecting Save from the File menu will save the data using the current document
name. You may also press the Save command button to select this option.
File: Save As

The Save As command is used to save the current input data on your disk with a
new document name. Select Save As in the File menu for this option.
File: Print
The Print option is used to make a complete, printed copy of both the input
engine design data and the calculated output parameters from ENGINE Pro.
The printout will also contain the data in the three ENGINE Pro calculation
Worksheets as well as the complete Engine Dyno Data, Mechanical and Intake
Port Flow Details, and Recommendations.
Selecting the Print command in the File menu (or the Print command button) at
any time will cause the printer to start printing. The printer should be turned on
and the paper aligned at the top of the page before the Print command is
selected.
File: Exit
The Exit command in the File menu can be used at any time to exit the ENGINE
Pro program and return to Windows.

CHAPTER 4: INPUT VARIABLES
How to Input
The ENGINE Pro program screen is where the editing required to build an
engine design data document takes place. This chapter of the ENGINE Pro
manual contains a complete, detailed description of all the input design
variables.
Before getting into the definitions of the input variables, let's discuss how you
provide input to ENGINE Pro via your computer keyboard and mouse. The
mouse is used to select the input variable to be changed. Most of the input
variables are edited by selecting them with the mouse and simply typing a new
value.
If you make a mistake when typing, use the Back Space key to backup and
erase, and then re enter your data.
Pressing the Tab key (or the Return or Enter keys) signifies the end of the
variable entry. The Tab key will also advance the cursor to the next input data
variable. Pressing the Return or Enter keys will hold the cursor in the current
input variable location.
A maximum of five digits may be input for the numeric variables. If more than
five digits are entered they will be ignored. Only numeric inputs are allowed.
Also, if you enter a value outside the range of acceptable engine design variable
inputs, you will receive a warning message on the screen and ENGINE Pro will
automatically change the value to be within the established program limits.
It is important to remember that pressing either the Tab, Return or Enter keys
signifies the end of the entry, and only then are the calculations for the engine
performance completed and the results displayed on the ENGINE Pro program
screen.
Some of the data values are determined by selecting from a drop-down menu.
An example of this type of input is the Camshaft Type. Use the mouse to click

the Camshaft Type list box and a menu will appear showing the possible
selections. Click the mouse button on the Camshaft Type that you are modeling.
Some of the data values are determined by selecting option or check boxes. An
example of this type of input is the Manifold Runner Style. Simply use the
mouse to select either the Curved or Straight option button.
The remainder of this chapter of the ENGINE Pro manual contains a complete,
detailed description for each of the input engine design variables. A complete
description of the three ENGINE Pro worksheets is also included beginning on
page 4-8.
Engine Design Data
Note: = A descriptive string of up to 255 characters used to more completely
identify the engine design data document.
Number of Cylinders = the number of cylinders that the engine design contains.
Normal values for the Number of Cylinders are between 4 and 8.
Inline, Vee or Flat option? = a set of option check boxes to select either an
inline, vee or flat type engine configuration. The flat option also includes all
opposed engine configurations.
Bore Diameter = the measured cylinder bore diameter of the engine design
expressed in either inches or millimeters. Normal values for the Bore Diameter
are between 3.00 and 4.50 inches or 65 and 100 millimeters.
Stroke Length = the measured crankshaft stroke length of the engine design
expressed in either inches or millimeters. Normal values for the Stroke Length
are between 3.00 and 4.50 inches or 65 and 100 millimeters.
Rod Length = the measured center to center length of the engine connecting
rods expressed in either inches or millimeters. Normal values for the Rod
Length are between 5.0 and 6.5 inches or 100 and 150 millimeters.

Compression Ratio = the measured mechanical compression ratio for the engine
design. Normal values for the Compression Ratio are between 9 and 16.
note: see page 4-8 for a description of the Compression Ratio Worksheet.

Camshaft Type: = a drop-down menu to select which type of camshaft and lifter
design are to be modeled by ENGINE Pro.
- overhead cam
roller cam and lifter
mushroom tappet
- high rate-of-lift flat tappet
normal flat tappet and solid lifter
hydraulic roller cam and lifter
normal hydraulic cam and lifter
Intake Duration @ .050 inch = the intake cam lobe duration measured at .050
inch valve lift expressed in degrees. Normal values for the Intake Duration @
.050 inch are between 200 and 280 degrees.
Throttle CFM @ 1.5 inches Hg = the measured total flow capacity of the engine
carburetor(s) or injector throttle body at 1.5 inches Hg pressure drop expressed
in cubic feet per minute (CFM). Normal values for one carburetor are between
390 and 1150 CFM. Normal input values for two carburetors may vary from
1300 to 2600 CFM.
note: 1.5 inches Hg equals 20.4 inches H2O
note: see page 4-10 for a description of the Throttle CFM @ 1.5 inches Hg
Worksheet.
Carb or EFI option? = an option check box to select either a carburetor, or a
mechanical or electronic fuel injection type fuel delivery system.
Fuel Type: = a drop down menu to select which type of fuel is to be modeled by
ENGINE Pro.
- gasoline
- racing gasoline
- methanol

Intake Manifold Type: = a drop-down menu to select which type of intake
manifold design is to be modeled by ENGINE Pro.
- plenum style (most common)
- individual runner (IR)
- dual plane, 100% divided
- dual plane w/small slot
Manifold Runner Style option? = an option check box to select either curved or
straight intake manifold runners. For example, single four barrel intake
manifolds for V8 engines typically have curved intake runners between the
carburetor and cylinder head. However, most dual four barrel sheet metal intake
manifolds for V8 engines have straight intake runners.
Intake Manifold Flow Factor = is a measure of how the intake manifold affects
the bare cylinder head flow. The Intake Manifold Flow Factor is the ratio of the
intake flow with the intake manifold attached and the bare head flow, expressed
as a percentage.
Both these flow values are measured on the flowbench at maximum net intake
valve lift at the same Test Pressure and Reference Bore Diameter. Normal
values for the Intake Manifold Flow Factor are between 90 and 98 percent.
Unported, cast intake manifolds can vary from 90 to 94 percent. Ported
aftermarket, cast single four barrel manifolds can achieve 97 percent. State of
the art aluminum sheet metal manifolds for two four barrel applications can
exceed 99 percent.
Number of Intake Valves per Cylinder = the number of intake valves per
cylinder for the engine design. Normal values for the Number of Intake Valves
per Cylinder are either 1 or 2, but some racing motorcycle and Formula 1 engine
designs currently have 3 intake valves per cylinder!
Intake Valve Diameter = the measured diameter of the intake valve head
expressed in either inches or millimeters. Normal values for the Intake Valve
Diameter are between 1.60 and 2.25 inches or 25 and 45 millimeters.
Maximum Intake Port Flow CFM @ Test Pressure inches H2O @ Reference
Bore Diameter = the intake flow at maximum net intake valve lift determined

from the measured flowbench data expressed in CFM. You must also input the
corresponding Test Pressure expressed in inches of H2O and the flowbench
Reference Bore Diameter expressed in either inches or millimeters.
Normal values for the Maximum Intake Port Flow vary considerably based on
the intake valve diameter and Test Pressure, but usually fall between 120 and
450 CFM. Normal values for the Test Pressure are between 10 and 28 inches
H2O. Normal values for the Reference Bore Diameter should be within 2
percent of the actual engine cylinder bore diameter.
Note: Always input the total intake flow for engines having more than one
intake valve per cylinder.
note: see page 4-12 for a description of the Intake Port Flowbench Data
Worksheet.
Compression Ratio Worksheet
The Compression Ratio Worksheet is displayed by pressing the Compression
Ratio button located at the Compression Ratio input variable position. Control
is returned to the main ENGINE Pro program screen by pressing the worksheet
close box when you are finished using this worksheet.
The Compression Ratio Worksheet is included with ENGINE Pro to help you
quickly determine what your current compression ratio is, or to determine what
combination of engine variables will give you the compression ratio you desire.
Each of the Compression Ratio Worksheet variables is fully described in the
following paragraphs.
Combustion Chamber Volume = the measured volume of the cylinder head
combustion chamber expressed in cubic centimeters (c.c.). This value may be
obtained from the cylinder head manufacturer or accurately determined by direct
measurement of the finished cylinder head. Normal values for the Combustion
Chamber Volume vary greatly, but generally fall between 40 and 100 c.c.
Piston to Deck Height = the measured distance that the top of the piston is
located below the block deck surface expressed in inches. If the top of the
piston rises above the block deck surface, the Piston to Deck Height would be

input as a negative number. Normal values for the Piston to Deck Height are
between 0.0 and .025 inches.
Head Gasket Thickness = the measured, compressed thickness of the cylinder
head gasket expressed in inches. Normal values for the Head Gasket Thickness
are between .018 and .048 inches.
Piston Dome Volume = the total measured volume of the piston dome expressed
in cubic centimeters (c.c.). This value may be obtained from the piston
manufacturer or accurately determined by direct measurement in the engine.
Normal values for the Piston Dome Volume vary greatly, but generally fall
between 10 and 25 c.c.
Throttle CFM @ 1.5 inches Hg Worksheet
The Throttle CFM @ 1.5 in Hg Worksheet is displayed by pressing the Throttle
CFM @ 1.5 inches Hg button located at the Throttle CFM @ 1.5 inches Hg
input variable position. Control is returned to the main ENGINE Pro program
screen by pressing the worksheet close box when you are finished using this
worksheet.
The Throttle CFM @ 1.5 inches Hg Worksheet is included with ENGINE Pro to
help you quickly estimate what your carburetor or throttle body flow capacity is,
or to determine what throttle and venturi diameters would be required to get the
airflow you desire.
Each of the Throttle CFM @ 1.5 inches Hg Worksheet variables is fully
described in the following paragraphs. The worksheet includes separate inputs
for the Primary and Secondary parts of the throttle, since these may have
different diameters for your specific application.
Number of Throttle Bores = the total number of throttle bores being modeled.
Normal values for the Number of Throttle Bores is between 2 and 8.
Throttle Diameter = the diameter of the throttle bore measured in either inches
or millimeters. Normal values for the Throttle Diameter are between 1.0 and 2.0
inches or 25 and 48 millimeters.

Venturi Diameter = the diameter of the throttle venturi measured in either inches
or millimeters. Normal values for the Venturi Diameter are between .875 and
1.75 inches or 20 and 40 millimeters.
Throttle Type option? = an option check box to select which type of throttle
design is to be modeled by ENGINE Pro.
- butterfly valve = this is the most
common style, used in most carburetors
and throttle bodies.
- slide valve = slide valve carburetors
are typically found on motorcycles
and do not have throttle shafts or
butterfly valves in the throttle bore
of the carburetor or throttle body.

Note: To display the equivalent Throttle CFM @ 3.0 inches Hg (a common
rating for two barrel carburetors), move the mouse over the calculated Throttle
CFM @ 1.5 inches Hg value.
Intake Port Flowbench Data Worksheet
The Intake Port Flowbench Data Worksheet is displayed by pressing the
worksheet button located at the Maximum Intake Port Flow input variable
positions. Control is returned to the main ENGINE Pro program screen by
pressing the worksheet close box when you are finished using this powerful
worksheet.
The Intake Port Flowbench Data Worksheet is included with ENGINE Pro for
two primary uses:
a) to help the engine designer without
flowbench data estimate the intake flow
capacity of a specific cylinder head
design based on the intake valve
diameter, lift, and valve job details.

b) to critique the flowbench data and
intake flow capacity results obtained
from a cylinder head porting shop.
Each of the Intake Port Flowbench Data Worksheet variables is fully described
on the following pages. These definitions are then followed on page 4-16 by a
description of how to use this powerful worksheet for the two situations listed
above.
Intake Valve Seat Throat Data
Valve Seat Throat Diameter = the diameter of the valve seat throat measured in
inches or millimeters. The Valve Seat Throat Diameter is always less than the
valve head diameter (also displayed for reference).
Valve Seat Throat Percentage = the ratio of the Valve Seat Throat Diameter to
the valve head diameter expressed as a percentage. Normal values for the Valve
Seat Throat Percentage are typically between 85 and 88 percent for stock heads
and 88 and 92 percent for racing heads.
Valve Seat Angle = the measured angle of the valve seat face expressed in
degrees. The most common Valve Seat Angle is 45 degrees, however some
cylinder heads may use a valve seat angle between 35 and 55.
Valve Seat Width = the width of the valve seat face measured in inches. Normal
values for the Valve Seat Width are between .060 and .090.
Valve Stem Diameter = the diameter of the valve stem measured in inches or
millimeters. Normal values for the Valve Stem Diameter are between .25 and
.375 inches or 4 and 8 millimeters.
Flowbench Data
The next section on the Intake Port Flowbench Data Worksheet is for the actual
flowbench data itself. A table providing for up to 10 pairs of lift (inches) and
flow (CFM) values is provided. For each set of input data, the area and a
number of flow velocity parameters are calculated.

Area = the calculated minimum cross section area of the intake port expressed in
square inches. This may be controlled by either the valve curtain area or valve
throat area depending on the input valve lift.
Please note that the intake port may be smaller at some other point. For
example, on many small block Chevy heads, the area next to the pushrod can be
a pinch point at very high valve lifts. The Cross-section Area Calculator may
be useful to help you with this important calculation.
note: see page 4-18 for a description of the Cross-section Area Calculator.
Flow Velocity = the calculated average intake port flow velocity expressed in
feet per second. Normal values for the Flow Velocity vary directly with the
flowbench Test Pressure as shown below:
@ 10" H2O - 130 to 185 ft/sec
@ 20" H2O - 185 to 240 ft/sec
@ 25" H2O - 210 to 270 ft/sec
@ 28" H2O - 225 to 285 ft/sec
@ 45" H2O - 290 to 375 ft/sec

Flow Flux = the calculated intake port flow flux expressed in CFM per square
inch of cross-section Area. Normal values for the Flow Flux vary directly with
the flowbench Test Pressure as shown below:
@ 10" H2O - 55 to 70 CFM/sq in
@ 20" H2O - 80 to 100 CFM/sq in
@ 25" H2O - 90 to 115 CFM/sq in
@ 28" H2O - 95 to 120 CFM/sq in
@ 45" H2O - 120 to 155 CFM/sq in
Flow Velocity Index = the Flow Velocity expressed as a percentage of the
maximum theoretical limit for the input flowbench Test Pressure. Normal
values for the Flow Velocity Index are between 70 and 90 percent. State-of-theart cylinder heads are currently able to achieve almost 100 percent of the
theoretical limit.
At the bottom of the Flowbench Data section is an area to input the Maximum
Intake Valve Lift for your engine design. After you input this value, ENGINE

Pro determines the corresponding intake port flow CFM and calculates all the
flow velocity parameters described above for this max lift value.
Maximum Intake Valve Lift = the measured max net intake valve lift expressed
in inches. This value can be calculated from the camshaft specs as the stated lift
minus the recommended valve lash. Normal values for the Max Intake Valve
Lift can vary greatly with intake valve diameter, but are usually between .450
and .750 inches.
Now, let's get back to the two situations described earlier and how to use the
Intake Port Flowbench Data Worksheet.
a) For the case where you have absolutely no cylinder head flowbench data,
start off by entering the actual Intake Valve Diameter on the main program
screen. Use the Intake Port Flowbench Data Worksheet to estimate the valve
seat dimensions and flowbench data for your engine design.
If the cylinder heads are totally stock enter a value of 65 percent for the Flow
Velocity Index at the Max Intake Valve Lift. If some work has been done to the
valve seat, throat and bowl areas a value of 70 75 percent might be appropriate.
If the heads have been fully ported by a professional head porting shop, 80 85
percent Flow Velocity Index at maximum lift is not uncommon.
ENGINE Pro will now estimate the flowbench data values as well as the
Maximum Intake Port Flow and display the result on the main program screen.
b) When critiquing cylinder head flowbench data, enter the Intake Valve
Diameter and estimated Maximum Intake Port Flow on the main program
screen. Use the Intake Port Flowbench Data Worksheet to enter all the valve
seat details, actual flowbench data and Maximum Intake Valve Lift.
ENGINE Pro will calculate all the flow velocity parameters and the critical Flow
Velocity Index. Professional port work should achieve a Flow Velocity Index of
at least 85 percent at the Maximum Intake Valve Lift. State of the art port work
can achieve over 10 percent more flow, approaching 100 percent for the Flow
Velocity Index at maximum lift.
Cross-section Area Calculator

The Cross-section Area Calculator is displayed by pressing the Area Calculator
button located along the top of the main program screen.
The Cross-section Area Calculator is included with ENGINE Pro to help you
quickly determine what the cross-section area is for four different flowpath
shapes. Each of the Cross-section Area Calculator variables is fully described in
the following paragraphs.
All Cross-Section Area Worksheets use:
Stem Diameter = the diameter of the valve stem measured in inches or
millimeters. Use this input only if the valve stem is actually present in the
flowpath.
Circular Area Worksheet:
Diameter = the diameter of the circular flowpath measured in inches or
millimeters.
Rectangular Area Worksheet:
Height = the height of the rectangular flowpath measured in inches or
millimeters.
Width = the width of the rectangular flowpath measured in inches or
millimeters.
Corner Diameter = the corner diameter of all four corners of the rectangular
flowpath measured in inches or millimeters.
Elliptical Area Worksheet:
Major Diameter = the larger diameter of the elliptical flowpath measured in
inches or millimeters.
Minor Diameter = the smaller diameter of the elliptical flowpath measured in
inches or millimeters.

Annular Area Worksheet:
Outer Diameter = the outer diameter of the annular flowpath measured in inches
or millimeters.
Inner Diameter = the inner diameter of the annular flowpath measured in inches
or millimeters.

CHAPTER 5: CALCULATED PARAMETERS
The calculated output from ENGINE Pro is separated into five parts - Estimated
engine performance, Engine Dyno Data, ENGINE Pro Recommendations, and
the ENGINE Pro Mechanical and Intake Port Flow Details. Please refer to the
output of the sample case on your computer monitor to get a complete
understanding of all the ENGINE Pro calculated output parameters.
Estimated engine performance
ENGINE Pro estimates overall engine performance for the "standard" ambient
conditions of sea level elevation, 29.92 inches Hg, 60 degrees F and no
humidity. This is the same "standard" that most aftermarket, racing and high
performance engine data is "corrected" to. Engine power and torque predictions
are consistent with the SAE (Society of Automotive Engineers) J1349 Standard
Method.
ENGINE Pro calculates the displacement of the engine and the eight key engine
performance parameters described on the next page. These output parameters
should be viewed as what's possible for the input engine design.
A few engines may be able to surpass these values using special exotic fuels,
synthetic lubricants and dry sump oil systems, and variable length intake and
exhaust systems . . . but not by much, usually no more than 2 3%.
Peak HP = the estimated maximum power (HP and kW) potential of the engine
described by the input engine design data.
RPM @ Peak HP = the predicted RPM at which the Peak HP will occur.
Peak HP/CID = the calculated peak HP per cubic inch of engine displacement.
Peak Torque = the estimated maximum torque (ft lbs and Nm) potential of the
engine described by the input engine design data.
RPM @ Peak Torque = the predicted RPM at which the Peak Torque will occur.

Peak Torque/CID = the calculated peak torque per cubic inch of engine
displacement.
Shift RPM = the RPM that the engine should be shifted at for best performance.
The recommended ENGINE Pro Shift RPM is simply 8 percent greater than the
RPM @ Peak HP.
Redline RPM = the maximum RPM for engine operation. The ENGINE Pro
recommended Redline RPM is based on mechanical stress limits for the crank,
rod and piston assembly - it has nothing to do with valve train dynamics!
Engine Dyno Data
The Dyno Data button located at the top of the ENGINE Pro program screen is
used to display the calculated horsepower and torque curves for the input engine
design. This data is displayed over the entire RPM range of the engine, just like
you get from an engine dyno.
ENGINE Pro Mechanical Details
The Mech Details button can be pressed at any time to display the ENGINE Pro
Mechanical Details screen. Detailed engine parameters are organized into three
distinct areas within this screen: Piston Speed Summary in the upper-left corner,
Geometric Data Summary on the left-hand side, and Piston Details on the righthand side of the screen.
Piston Speed Summary:
The Piston Speed Summary includes both the average and maximum piston
speeds at the four engine rating points of peak TQ, peak HP, shift RPM and
redline RPM - expressed in feet per minute (FPM). It also includes the
crankshaft angle after top dead center (TDC) when the maximum piston speed
occurs and the Estimated Cranking Compression.
Avg Piston Speed = the average speed of the piston expressed in feet per minute
(FPM). Avg Piston Speed is a simple function equal to the crankshaft stroke (in
inches), multiplied by the RPM, and divided by 6.

Max Piston Speed = the maximum speed the piston obtains expressed in feet per
minute (FPM). Max Piston Speed takes into account the eccentric motion of the
piston due to the crankshaft and connecting rod assembly. The Max Piston
Speed will always be much greater than the Avg Piston Speed.
Geometric Data Summary:
The Geometric Data Summary includes a number of non-dimensional
parameters that describe several key features of the overall engine design.
These non-dimensional parameters allow a quick comparison as to the geometric
similarity of two engine designs having vastly different displacements.
Bore to Stroke Ratio = the ratio of the bore diameter and crankshaft stroke
length.
Rod to Stroke Ratio = the ratio of the connecting rod length and crankshaft
stroke length.
Piston to Head/Rod Length = the ratio of the total piston to head clearance at
TDC and the connecting rod length.
Intake Throat/Bore Area Ratio = the ratio of the intake port minimum crosssection area and the bore area. Normally, the intake valve throat is the section
of minimum cross-section area.
Intake Valve Lift/Diameter Ratio = the ratio of the input maximum net intake
valve lift and the intake valve head diameter.
Piston Details:
Piston Details are provided for a number of different crankshaft angles for each
of the four engine rating points of peak TQ, peak HP, shift RPM and redline
RPM.
The engine rating points and corresponding RPM are included in the Piston
Speed Summary at the left of the Piston Details table as a menu list. You can

easily select among the four engine rating points by clicking the mouse on the
desired rating point RPM.
deg ATDC = the crankshaft angle expressed in degrees after TDC (ATDC). The
motion of the piston is assumed symmetric about TDC, thus the calculated
piston depth and speed values will also correspond to crankshaft angles before
TDC.
For example, at 45 degrees before and after TDC the piston will be in the same
position relative to TDC and have the same speed and acceleration.
depth (inch) = the distance the piston is displaced from TDC along the cylinder
expressed in inches.
Piston Speeds (FPM and FPS) = the actual piston speed along the cylinder at this
crankshaft angle and rating point RPM, expressed in both feet per minute (FPM)
and feet per second (FPS).
g's accel = the actual piston acceleration along the cylinder at this crankshaft
angle and rating point RPM, expressed in g's. Positive g's result in tension in the
connecting rod whereas negative g's result in compression.
note: 1.0 g = 32.174 ft/sec/sec
The graph located in the lower portion of the Mechanical Details screen includes
the calculated Piston Speed and Depth details plotted against the crankshaft
angle ATDC.
ENGINE Pro Intake Port Flow Details
The Flow Details button can be pressed at any time to display the ENGINE Pro
Intake Port Flow Details screen. Detailed engine parameters are organized into
three distinct areas within this screen: Piston Speed Summary in the upper-left
corner, Camshaft Description on the left-hand side, and Flow Details on the
right-hand side of the screen.
Piston Speed Summary:

The Piston Speed Summary includes both the average and maximum piston
speeds at the four engine rating points of peak TQ, peak HP, shift RPM and
redline RPM - expressed in feet per minute (FPM).
Avg Piston Speed = the average speed of the piston expressed in feet per minute
(FPM). Avg Piston Speed is a simple function equal to the crankshaft stroke (in
inches), multiplied by the RPM, and divided by 6.
Max Piston Speed = the maximum speed the piston obtains expressed in feet per
minute (FPM). Max Piston Speed takes into account the eccentric motion of the
piston due to the crankshaft and connecting rod assembly. The Max Piston
Speed will always be much greater than the Avg Piston Speed.
Camshaft Description:
The Camshaft Description includes values that define both the cam lobe shape
and orientation of the intake valve lift as a function of crankshaft angle. The
initial values are set based on values from the ENGINE Pro main program
screen, and the Intake Port Flowbench Data Worksheet and ENGINE Pro
Recommendations.
Intake Duration @ .050" = the intake cam lobe duration measured at .050 inch
valve lift expressed in degrees. Normal values for the Intake Duration @ .050
inch are between 200 and 280 degrees.

Intake Lobe Centerline = the location of the camshaft intake lobe centerline
expressed in degrees ATDC.
Maximum Valve Lift = the measured maximum net intake valve lift expressed
in inches. This value can be calculated from the camshaft specs as the stated lift
minus the recommended valve lash. Normal values for the Maximum Valve
Lift can vary greatly with the valve diameter, but are usually between .450 and
.750 inches.
Flow Details:

Flow Details are provided for a number of crankshaft angle positions for each of
the four engine rating points of peak TQ, peak HP, shift RPM and redline RPM.
The engine rating points and corresponding RPM are included in the Piston
Speed Summary at the left of the Flow Details table as a menu list. You can
easily select among the four engine rating points by clicking the mouse on the
desired rating point RPM.
deg ATDC = the crankshaft angle expressed in degrees after TDC on the intake
stroke.
Valve Lift (inch) = the valve lift for this crankshaft angle as determined from the
Camshaft Description.
Flow Area (sq in) = the calculated flow area for this valve lift based on the
Intake Valve Seat Throat Data on the Intake Port Flowbench Data Worksheet, at
this rating point RPM.
Piston Speed (FPM) = the actual piston speed along the cylinder at this
crankshaft angle and rating point RPM, expressed in feet per minute.
Piston Flow Demand (CFM) = the actual volumetric displacement rate at the
intake valve throat due to the instantaneous piston speed at this crankshaft angle
and rating point RPM, expressed in CFM. The Piston Flow Demand is the
actual airflow demand (CFM) the moving piston within the cylinder is placing
on the cylinder head!
Note that the peak Piston Flow Demand lags the maximum piston speed by a
few degrees of crankshaft rotation. This is caused by the time lag as the piston
flow demand signal traverses the cylinder from the piston dome to the intake
valve throat at near sonic velocity.
Flowbench Velocity (FPS) = the calculated flow velocity at the intake valve
throat for this crankshaft angle and rating point RPM, expressed in feet per
second.
Flowbench Test (in H2O) = the test pressure required to accurately simulate this
engine operating condition on the flowbench, expressed in inches of H2O. Note

that this test pressure may be much higher than that used for the actual input
Flowbench Data.

The graph located in the lower portion of the Intake Port Flow Details screen
includes the calculated Flow Area, Piston Flow Demand and Flowbench
Velocity details plotted against the crankshaft angle ATDC for the intake stroke.
ENGINE Pro Recommendations
The estimated engine performance from ENGINE Pro should be viewed as the
engine's power and torque potential based on the key input engine design
variables. In order to achieve this engine performance level other design
parameters must also compliment the overall engine combination and design.

The Recommendations button is used to display recommended values for these
other significant engine design parameters. These design parameters have not
shown as strong an influence on engine performance as the ENGINE Pro input
design variables, but nevertheless, must be at or close to their optimum values to
achieve the engine's performance potential.
The ENGINE Pro engine design parameter recommendation are based on
research and analysis of a wide range of high performance and racing engine
designs.
The ENGINE Pro recommendations for the Intake System and Camshaft should
provide a free flowing intake track with "tuning" optimized for the calculated
RPM range of the engine.
Intake System:
Intake Valve Lift = the maximum gross intake valve lift required stated in
inches. This value considers the intake valve diameter, cylinder head flow
capacity, camshaft and lifter type, and RPM range of the engine.

Minimum Flow Area = the minimum cross-section area to be found anywhere in
the intake port stated in square inches.
Total Intake Track Length = the intake track length that provides the best
"tuning" for the input engine design. The Total Intake Track Length is the
length from the valve head to the first "abrupt opening". Typically, the first
"abrupt opening" occurs under the carburetor(s) in the plenum area of the intake
manifold. For IR systems the first "abrupt opening" is the open end of the air
inlet stack of the carburetor or fuel injector.
Maximum Flow Area = the cross-section area at the first "abrupt opening" stated
in square inches. The Maximum Flow Area is based on the optimum runner
taper ratio and Intake Track Volume. Always utilize a smooth, gradual runner
taper to achieve the Maximum Flow Area - do not create steep gradients
anywhere in the intake track.
Total Intake Track Volume = the volume of the "tuned" intake track stated in
c.c. The Total Intake Track Volume is the volume from the intake valve head to
the first "abrupt opening". It is the sum of the intake port volume and intake
manifold runner volume. For IR intake systems it also include the carburetor
volume to the top of the velocity stack.
Plenum Volume = the recommended engine plenum volume stated in cubic
inches.
Camshaft:
Lobe Separation Angle = the angle between the camshaft exhaust lobe and
intake lobe centerlines stated in camshaft degrees.
Intake Lobe Centerline = The camshaft may need to be advanced or retarded
from the straight-up setting but usually no more than 2 degrees in either
direction.
Exhaust Duration @ .050 inch = the exhaust cam lobe duration stated in degrees.

The ENGINE Pro recommendations for the Exhaust Port and Exhaust System
should provide a free flowing exhaust track with "tuning" optimized for the
calculated RPM range of the engine.
Exhaust Port:
Exhaust Flow = the recommended exhaust flow stated in CFM at the input
flowbench Test Pressure and Reference Bore Diameter. This value is also stated
as a percentage of the input Maximum Intake Port Flow.
Note: There are two methods for flow testing exhaust ports in common use
today. One is to flow the exhaust port bare, the other is to flow the exhaust port
with a pipe attached to the header flange of the head. Flowing the exhaust port
with a pipe normally increases the maximum lift flow about 10 percent.
The ENGINE Pro recommendations for exhaust flow assume the use of a pipe
intended to simulate the engine's primary header tube. If a "stub" pipe is used
on the flowbench, it's length should be at least 6 pipe diameters.
Exhaust Valve Diameter = the recommended exhaust valve head diameter stated
in either inches or millimeters. For engine designs with two or more intake
valves, ENGINE Pro assumes two exhaust valves will be used.
Exhaust Valve Lift = the maximum gross lift required at the exhaust valve stated
in inches. This value considers the exhaust valve diameter, cylinder head flow
capacity, camshaft and lifter type, and RPM range of the engine design.
Minimum Flow Area = the minimum cross-section area to be found anywhere in
the exhaust port stated in square inches.
Maximum Flow Area = the maximum cross-section area at the exit of the engine
exhaust port stated in square inches.
Exhaust System:
Primary Tube Length = the primary header tube length that provides the best
overall "tuning" for the input engine design. The Primary Tube Length is the
total length from the cylinder head flange to the first "abrupt opening".
Typically, the first "abrupt opening" occurs in the collector of the exhaust
header.

Primary Tube Diameter = the outer diameter of the primary header tube stated in
inches. Multi-step headers may get larger than the Primary Tube Diameter as
they approach the collector, but usually no more the 1/8" per step.
Collector Diameter = the recommended exhaust collector outer diameter stated
in inches.

